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Review Exercise: The Start Menu 
Chap 1 Windows 7 for Seniors 
 
 
 
 

 
 

Personal Folder = _____ Search Box = ______ 

Special Folders = _____ All Program Menu =  ______ 

Pinned Programs = ______ User Account =  ______ 

Common Tools = _____ Recent Programs = __B_ 

Help =   _____ Application column = ______  
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Windows 7for Seniors Review Topics 
 
You should be able to do the follow from previous Introduction to 
Computers course: 
 

1. Launch any application from the Start Menu. (1.13)  

2. Use the scroll wheel on the mouse. (2.5) 

3. Move and resize a window to any position on the desktop. (2.6) 

4. Shortcut Menu or the Right-Click. (2.12) 

5. Customize your mouse for the left-handed.  (Chap 2 tips, p95) 

6. Using the cursor key     arrows.  (3.9). 

7. Create a new document. (3.14) 

8. Launch more than one application. 

9. Maximize, minimize and restore a windows. 

10. Close a program. 

11. Shutdown the computer properly. 

12. Type and save a letter in WordPad. 4.1 - 10 

13. Copy, cutting and pasting within a document. (5.11) 

14. Selecting and word or paragraph by dragging.(5.5) 

15. Selecting a paragraph (5.7) 

16. Create a new folder. (6.7) 

17. Copy a file.  (6.8) 

18. Move a file.  (6.9) 

19. Dragging and dropping files.  (6.10) 

20. Copying to a flash drive.  (6.15) 

 

If you do not understand any of these topics, please 

review the chapter numbers --which are in parentheses, 

in the Windows 7 for Seniors manual. 

Website:  http://www.visualsteps.com/windows7/ 

You can also down entire chapter 2 for FREE. 

 

Other references can be found on my web page: 

 

http://aeromaniacs.com/class/intro.html 

  

http://www.visualsteps.com/windows7/


4 

 

Windowing Skills 
Ch 1-2, Window 7 for Seniors 
The skill of opening and working with multiple windows are essential for file 
management.  The ability to move, copy and delete files and folders require are able to 
manipulate your windows environment. 

Exercise 1a – Launch an Application Windows 

All application are represented is its own windows on the desktop.  All windows have 
the same basic element like border, title bar and control box. 
 
Windows allowed users to execute multiple graphical applications at the same time, 
through a process known as multitasking. 
 

 
Title Bar Menu Bar Tool Bar Workspace     Windows Control Box 

  

 
 

Status Bar    Scroll Bar  

 
 
Note: On newer application the Menu and Tool bar has been combine to a simpler 
interface know as the Ribbon. 
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Example of the Ribbon for Microsoft Office Word application 

Exercise 1b – Move a Windows 

Chap 2.3 Dragging – Window 7 for Seniors 
Position the mouse pointer on the windows title bar.  Hold down the left button while 
you drag the window to another location on the desktop. 

 
 

Exercise 1c – Resize a Windows 

Chap 2.6 , p 97– Windows 7 Visual Steps 
Position the mouse pointer on the window border you wish to size.  When the mouse 
pointer changes to a double arrow, drag the border to the desired size.  You can resize 
either horizontally or vertically.  Hint: Place the mouse on the corner and you can resize 
both horizontally and vertically at the same time. 
 

 
Tip:  Look for the double arrow pointer before you move the mouse. 
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Exercise 1d – Launching Multiple Windows 

Review Ch 2.3,2.6 
1. Launch WordPad, Paint, Calculator and Internet Explorer: 

 
Resize and move the 4 windows to look like the diagram below with no borders 
touching.  Use the Star Menu. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tip: Resize from the corners to adjust both horizontal and vertical together.  
Drag the title bar to move the window. 

 
2. Open Internet Explorer from the Task Bar. 

3. Open Wordpad which can be found in All Programs under Accessories. 

4. Open Paint which also can be found under Accessories. 

5. Open the Calculator. 

6. Type your name in Wordpad.  Notice that the title bar of the active application is 

darker that the other windows. 

7. Click on every windows to make it active.  Notice that change in the title bar. 

8. Minimize all of the windows. 

9. Restore each window by clicking on each of the active icon in the Task bar. 

 

Auto-arrange Windows 

1. Right-click in a blank area of the task bar, select Cascade windows. 

2. Right-click in  a blank area of the task bar, select Show windows side by side. 

3. Right-click in  a blank area of the task bar, select Show windows stacked. 

  

IE 
WordPad 

 Paint 
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Windows Control Box 
Not the Windows Button as stated in the book. 
The Windows control box is a series of three buttons on the top right-hand corner of a 
window that are used to minimize, maximize, restore down and close the window.  
What is the purpose of the Windows Control Box?  It allows you to manipulate the look 
of multiply windows, so that you can work on more that one task at a time. 
 

  
 
 
 

 The Minimize button shrinks the window it turns it into a button located in 
the Windows task bar.  The program still remains in RAM. 
 
 The Maximize amplifies the size of the window to fill the whole screen.  In 
this state for borders disappear and the user can not perform any resizing 
of the window. 

 
From the Maximize state, the button will change to Restore Down, 
allowing you to return the window to its original state. 
 
The Close button closes the window.  The program is released from RAM 
memory.  Therefore, if you make any changes to a document, you will be 
asked if you wish to Save the changes before closing.  The default is Yes. 

 

THE KEYBOARD 
 

 
The arrangement of characters on a QWERTY keyboard was designed in 1868 by 
Christopher Sholes, the inventor of the typewriter. According to popular myth, Sholes 
arranged the keys in their odd fashion to prevent jamming on mechanical typewriters by 
separating commonly used letter combinations.   

Minimize  Maximize/Restore  Close 
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Exercise 2a – Minimize 

Minimize put the application down to the taskbar.  The application is still active.  To 
retore it back to the previous view, click on the highlighted icon. 
 

1. Click on the Minimize button for each window. 
2. Notice that the active applications are highlighted. 
3. Mouse over the highlighted icon.  You can see a “Live Preview” (Win 7 new 

feature). 
 

 
 

4. Click on each of the active icons (Paint, Wordpad, IE and Calculator) to restore 
each window back to its original view. 

 

Exercise 3a – Maximize and Restore 

 
1. Click on the Maximize button for each window. 
2. Click on the Restore button for each window. 

What does Restore do? 
3. Click on the Minimize button for each window. 
4. Click on the Minimized application in the taskbar. 

 

Tip:  ++ M to minimize all windows.  Press the Windows logo key  +D. (To 

restore minimized windows, press the Windows logo key  +D again.) 

Exercise 3b –Auto Maximize and Shake 

 
1. Drag the windows to the very top of the screen. 

2.  +  (down arrow) to restore the view. 
3. Click on the title bar of the active windows you want to keep and shake.  Notice 

that all of the other windows are Minimized 
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Exercise 4– Foreground and Background Window 

The foreground window to the window that is on top is the active windows. 
 

1. Move the windows around using the Title Bar so they overlap each other.  
 
 
 
 
 
 
 
 
 
 
 
 
Notice that the Title Bar is highlighted on the fore ground application. 
 

2. To bring a background application forward, just click on any visible part. 
3. Another method is to click on on of the active icon in the Task Bar. 

 

 
 
 

The arrow point to all of the active applications 

Exercise 5 –Switch Active, Shuffle and 3D Flip * 

1. Restore windows. 
2. Press Alt+Tab, then press Tab a few more times. 

What do you see? 
3. Click the Alt+Esc several times. 

What do you notice? 
 
 

4. Press Window Key + Tab 
Continue pressing tab key. 
What happens? 

 

 3D flip does not work in basic version of Windows or if the Basic theme is 
selected. 
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Exercise 6–Aero-Snap * 

1. Maximize windows by dragging (title bar)  the windows to the top of the desktop. 
2. Expanded window vertically by dragging (top border)to edge to the top of the 

desktop. 
3. Split screen: Drag the window to the left or right of the desktop as far as you can.  

The result will be a 50% slip windows either on the left or right. 
 

 
 
 
Tip: Use shortcut key:  (Windows key)  +  and  +   

Why? 

The ability to create a dual-pane will make it easily to move or copy file from one place 
to another. 
6.16 Copying to a USB Stick, Windows 7 for Seniors. 
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Intro to Windows-Part 2 
(Windows XP,Vista & 7) 
Instructor: Heman Lee 

The skill of copy, cut & paste is one of the most important skills you must master.  Unlike 
what its simple name suggest, copy &paste or cut & paste is a universal concept that all 
computer systems use to manage files or create DVD or other media such as digital 
photos, video, etc. 

Exercise 1 – Copy & Paste Menu 

Edit Menu vs Clipboard Menu 

  
 
The copy, cut and paste function has moved to the Clipboard menu in Windows 7 
WordPad and newer Microsoft application such as Office 2010. 
 
Cut & Paste is the same as moving text or graphics from one place to another.  When 
you cut something, only one copy exist versus Copy where both text or graphic exist. 
 

1. Open Wordpad. 
2. Open file Cut & Paste.rtf.  (open folder Exercises). 
3. Complete the entire exercise. 
4. You can use Drag & Drop method to move items. 

 
Open file Copy & Paste.rtf and do the same. 
 

Remember the 3 basic steps: 

 

Selection     Cut or Copy  Paste 
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Exercise 2– Cut/Copy & Paste from one windows to another 

 
 

 
Sample of Firebox Web Browser 

 
1. Find an image on the Internet using Google image search. 

2. Click on the image until you can see the Full-size image link.\ 

3. Use the Right-Click to copy the image. 

4. In WordPad, type the heading: B-Day PARTY, press [enter] to go the next line.  

Leave the cursor on the 2nd line. 

5. In the address bar of IE type:  

6. Right-click on image of hamburger and select Copy. 

7. In WordPad, place the I-beam on the 2nd line. Right-click(Shortcut menu) and 

select Paste.  Yes can also select Paste or Ctrl+V.  Alternate method: from the 

Clipboard menu, select Paste. 

 

Remember your keyboard shortcuts: 

Ctrl + C to Copy 

Ctrl + X to Cut 

Ctrl + V to Paste 

 

 

  

Copy 
Tip: Use Right-
click shortcut 

google.com 
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Save VS Save As 

Exercise 3 – File Menu Save/Save As 

 

 
 
Save 
 

 To Update changes an existing file.  ( Does not prompt you ) 
 

Save As 

 

 The first time you save a newly created file. 

 To save the same file to a new folder or disk. 

 To save the same file with a different name, thus keep the old copy intact. 
 
 

1. In WordPad to the File Menu and select Save.  You will see the Save As dialog 
box (fig 2.1). 

2. Save the document with the name: Bday Card. 
3. Click the Save button. 

 

Save to a folder 

 
1. Select File Menu>Save As. 
2. In the Save As Dialog box, click New Folder. 
3. Give the folder your name. 
4. Click the Save button. 

 

Save to a flash drive. 

1. In the Save As dialog box, use the folder pane on the left and scroll down until 
you see Computer. 

2. Click to view content of Computer in the main pane. 
3. Locate your flash drive and click on it to view its content. 
4. You can create a new folder on your flash dirve. 

File menu 
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5. Click the Save button to perform the action. 

Save As Dialog Box 

This appears when you save your file for the first time.  Even if you forget and/or press 
Save instead of Save As the application will always force you to do a SAVE AS. 
 

 
Fig 2.1 

 

Save Dialog Box on exit. 

 

 
 
 
 
 
 
 
 

  

Save and exit 
Don’t Save and 
exit 

Abort and 
go back to 
the 
program. 

This screen can be 
very confusing for the 
novice user. 
 
To save a file you only 
need 2 thing: where 
and what. 

1. Location 
2. Filename 
3. Type 

(optional) 
Unfortunately, we 
can spend a whole 
chapter on location, 
but in a nutshell file 
are located in folders.  
You just have to 
locate the right 
folder. 

Why are people 
confused that this 
does not exit?  If you 
abort turning off the 
lights nothing is go 
happen. 
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Jump Lists 
 

 
 

A Jump List is similar to Recent Files on the old Start Menu.  In Windows 7 is takes you 
right to the documents, pictures, songs, or websites you turn to each day. To open a 
Jump List, just right-click a program button on the Windows 7 taskbar. (You can also get 
to Jump Lists by clicking the arrow next to the program name on the Start menu.) 

The search box 

The search box is one of the most convenient ways to find things on your computer. The 

exact location of the items doesn't matter—the search box will scour your programs and 

all of the folders in your personal folder (which includes Documents, Pictures, Music, 

Desktop, and other common locations). It will also search your e-mail messages, saved 

instant messages, appointments, and contacts. 

 
The Start menu search box 
 

1. To open Paint, just type P.  Notice that the autocomplete will automatically 
display your match immediately.  By the time you type Pa, Windows has already 
found what you were looking for. 

2. Type: http://cnn.com 
  

Right-Click 

http://cnn.com/
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Intro to Windows-Part 3 

Exercise 1 – Windows Explorer (Folder Windows) 
Chap 6 – Window 7 for Seniors, Chap 5.1, More Windows 7 
The Windows Explorer is an indispensable tool in an operating system, since with it we 
can organize and control the files and folders of the different storage systems at our 
disposal such as the hard drive, disk drive, etc. 
 
The Windows Explorer is also known as the File Manager on previous version of 
Windows. Through it we can view, sort, delete, copy, or move, burn a CD files and 
folders. 
 

Windows 7 

 

 
 
 

FOLDER HIERACHY 
Before we can continue, you must first 
understand Windows Vista folder hierarchy.  
Folders are organized like an inverted tree 
with branches to represent sub-folder.  The 
root which represents the highest level is at 
the top of the tree.  Sometime we refer to this 
folder as the parent folder.  Folders under the 
parent are referred to as sub-folders. 
The  symbol indicates more sub-folders.  
Click on it to expand the view.  

Tool Bar View Preview 

Content Pane Navigation Pane 

Address Bar 
(bread crumbs) 
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Navigating to the Parent Folder 
Tips 6.21,Ch 6.3,  “Understanding the Different Parts of a Folder Windows”, Windows 7 
for Seniors. 
This the same as the UP folder button in Window XP.  In this example, Document is the 
current folder.  Simply click on Steve to navigate to it’s parent.  You don’t have to click 
on the parent, you can click on any folder name in the address bar. 
 
 
 
 
 

 
 

 
 
 
 
 
 
 
 

Exercise: Open Your Personal Folder 

Ch 6.1, 6.2 Tips, Window 7 for Seniors 
 

1. From the Start menu, ,open yourpersonal folder. ( Chap 6.1 - Windows 7 for 
Seniors) 

2. Change your view to Large Icon. (Ch 6.2) 
3. Open My Documents. 

Use 3 methods: from Double-click on icon, Address bar and Navigation pane. 

 

Exercise: Navigating the Address Bar – Parent  Folder 

In these examples, Student is your personal folder.  I might be you name on you home 
system. 

4. Current Folder: 
StudentPictureFamilyDisney Vacation 

 
5. Click on Family 

 Student PictureFamily 
 

6. Click on Picture 
 Student Picture 

 
7. Click on Studen 

 Student  

Click to view sub-
folders 

Student Document 

Click to view 
parent’s sibling 
folder 

Parent’s folder 
Recent folder 

Current folder 
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EXERCISE –Open student CD 

Ch 2.11 ,6.1 Window 7 for Seniors, Ch 4.6 -what is inside my computer,More Windows 7 
 

1. Insert  your Student CD in the CD/DVD drive bay.  

2. If the AutoPlay appears, close it. 

3. Navigate to Computer in the folder pane. 

4. Click on the CD drive icon in the left panel.   

 

 
Note: XP users navigate to My Computer.  If you do not have a desktop icon, go to the 
Start Menu. 
 
 

EXERCISE - View the contents of a Flash Drive 

Ch 6.2, The folder list in the navigation pane, Windows 7 for Seniors. 
 
With your Student CD in the drive - click on the CD E drive icon in 
the left panel.  The “Folder Pane” to the right will display the 
contents of your CD – path: click on every  symbol (formerly the 
+ sign) 
 

1. Open Computer from the Start Menu. 

2. Click on the icon that represents your Flash drive.  Note: Look for Removable 

Storage.  Some flash drive have name like SanDisk. 

3. Scroll through the contents of the Navigation pane (left panel) and click on every 

 sign to expand the folders. 

4. After you have expanded all folders, click on every  to collapse the folder view.. 

5. Click on the folder to see the contents in the main pane. 

 

 
 

 
Important Point:  Again, notice that expanding or collapsing the folders, does not 
affect the view in the main pane. 
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Saving a Document to a Folder 

Ch 6.6 Creating a New Folder, 6.7 Saving to a Folder , Windows 7 for Seniors 
 

1. Launch WordPad. 

2. Create a letter. 

3. Do a File>Save which is the same a Save as on a new document. 

4. Notice that the Save as dialog box look like Windows Explorer with an extra Save 

button on the buttom of the screen. 

You can perform all of the same navigation exactly the same way. 

 

 
 

5. Create a folder name Letters. 

6. Double-click on the folder to open it. 

7. Click the Save button. 

Saving a Document to a USB Stick (Flash Drive) 

Ch 6.15 Copying to a USB Stick, 6.7 Saving to a Folder , Windows 7 for Seniors 
1. From the Save As dialog box, Insert your flash drive.  Close the AutoPlay dialog 

box if it appears.  (You can disable this under Default in the Control Panel) 

2. Instead, navigation to the Computer in the Navigation (left pane). 

3. Expand the folder by click on the  triangle symbol .  

4.  Look for your flash drive and click on it. 

5. Create a new folder called Letters. 

6. Click kthe Save button. 
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CREATE A FOLDER 

Chap 6.6 Windows 7 for Seniors or Chap 8.4 n- More Windows 7 
In order to organize all of your file, you first need to create folder and subfolders(folder 
within a folder).  Folder and files can be copied, movied, renamed and deleted.   
 
Here are 3 basic methods to create a folder: 

Method 1 – File Menu  (Alt Key) 
Select the source item and go to the File Menu - New>Folder 
 

Method 2 – Organize Menu  (Vista)  (Win 7) 
Select the source item and go to the Organize>New Folder 
 

Method 3 – Right-Click 
Right click on the selected item and select New. 
On the cascading menu mouse over the Folder and click on it. 
 

Shortcut: SHIFT + CTRL + N, 

RENAME A FOLDER 

When you first create a new folder, you have that opportunity to name it.  It you miss 
that, or you misnamed it you can rename it at any time.  
 
Here are 3 methods to rename a folder.  Do you notice a pattern?  
Click on the folder you want to rename. 

Method 1 – File Menu  (Alt Key) 
Select the source item and go to the File Menu - Rename 

Method 2 – Organize Menu  
Select the source item and go to the Organize>Rename 
 

Method 3 – Right-Click 
Right click on the selected item and select Rename.. 
 

 
Method 4 – Click on the filename twice slowly 
Click, pause, and then click. 
When the filename is highlighted in blue, you can retype a new name or deleted part of 
the name using the backspace or delete key. 

Rename This 
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EXERCISE - CREATE A FILE STRUCTURE 

Under Vista virtual folder “Document”, create the following structure for your 
document word files.  In Windows 7 create this under Documents>My Document library. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Here are 2 basic methods to create a folder structure: 
 

 
Method 1 –Create in their proper sub-folder 

1. Navigate to Document folder. 
2. Create a new folder called “Letters”. 
3. Double click on the Letters icon. 
4. Create a new folder called “Family”. 
5. Double click on the Family icon. 
6. Create a new folder called “Business”. 
7. Double click on the Business icon. 

 

 
Method 2 –Create all folders first 

1. Navigate to Document folder. 
2. Create all folders: Letters, Family, Friend and Business 
3. Drag Family folder icon over Letters until it turn blue. 
4. Drag Friends folder icon over Letters until it turn blue. 
5. Drag Business folder icon over Letters until it turn blue. 

 
 

 

  

Letter
sss 

Friends Family Business 
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Copying a File 

6.8 Window7 for Senior 
 

1. In My Document folder, create a folder called Letters. 
2. Select the file.  (Selected file has a blue hallo around it) 
3. Select Copy from the Organize Menu. 
4. Click in a white area to specify your destination folder.  In this case you are 

copying the file to the same folder. 
5. Select Paste from the Organize Menu. 

Now you will see a copy of the file in the same folder. 

Copy to a folder 

1. Now select the Letters folder. 
2. Select Paste again. 

Now open the Letters folder.  Notice that the same file is also in the Letters folder. 
 

Moving a File 

6.9  Window7 for Senior 
 

1. In My Document folder, create a folder called Business Letters. 
2. Select the file.  (Selected file has a blue hallo around it) 
3. Select Cut from the Organize Menu. 
4. Click in a white area to specify your destination folder.  In this case you are 

copying the file to the same folder. 
5. Select Paste from the Organize Menu. 

Now you will see a copy of the file in the same folder. 
What is the difference? 

 
 

Drag & Drop 

6.10 Window 7 for Seniors 
 

1. In My Document folder, create a folder called Letters. 
2. Drag a file to the Letters folder. 
3. When the mouse arrow is on top f the folder, look for the box that appears: 

 

 Move to letters 
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Selecting Multiply Files 

6.11, p 196, “Selecting Multiply Files”, Windows 7 for Seniors 
 

Non-contiguous Selection 

 
Use the Ctrl key to select files in random order. 
 

 

If you can not sort the list so that it falls into a contiguous pattern, you can use non-
contiguous selection. Select the first entry. It does not have to be the top most. 
Hold down the Control (Ctrl) key while you click on other files.  
 

Select All Files 

 

From the Edit menu, click Select All. 
 

From the Organize menu, click Select All. 
 

Ctrl- A 

If you wish to select all file in the current folder, hold down the 
CTRL key and press the letter “A”.   To de-select, just click on any 
white area. 

 
Tip:  Rather than selecting all files, you can just go to the parent and select the folder. 
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Contiguous Selection 

6.11 Tip, p 197 “Selecting a consecutive group of files”, Windows 7 for Seniors 
 
This will select a consecutive groups of file. 
 
First select the topmost file on the list   The selected file will appear with a light blue 
background, hold the  Shift key and immediately click on the bottom-most entry.   All of 
the files should now appear with a light blue background. 
Once the block is selected, you can move, copy, delete or rename it in a single 
procedure.   Once selected, DO NOT click the mouse anywhere else, it will deselect your 
selection.  
 

 
 
In the above example, we first sorted the detail view by Name.  This allowed us the view 
the file name that begin with “Ex” on consecutive order.  Now we can use Contiguous 
Selection to move these file to our “WordPad” Exercise folder. 
  

Contiguous 
Selection 

1. Click top most 
2. Hold the Shift key 
3. Click bottom most 

entry. 
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Advanced Skill 
Most kid already not how to select thing without memorization.  They simply Drag a 
imaginery box around their selection.  This can be very difficult for seniors.  It requires a 
very steady had. 
 

 
 
Tip 
The most difficult part is starting in a “white-area”.  A white area is the areas that exist 
between icons that is not part of the icon. 
 
Warning: If you are not able to do this, you can very easily drag a file to a folder and 
loose it. 

Drag and Drop Default (Copy vs Move) 
If you drag and drop from two different drive letter or device, the original file always 
remains in place; a copy is created in the destination folder. 
 

 
 
 
 
 
 
  

Start in a white 
area. 
Drag a box 
around your 
selection 

Copy 
C: Hard Drive 

K: Flash 
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Part 3b – Windows Explorer: Review Questions 

 

1) How do I launch Windows Explorer? 

a. Start Menu, Accessories, Windows Explorer 

b. Start Menu, Computer 

c. Click on your personal folder icon 

d. Start Menu, Document. 

e. Start Menu, Pictures 

f. All of the above. 

 

2) How do I navigate to different folders? 

a. Use the address bar. 

b. Use the favorites. 

c. Use the back button. 

d. Use the folder pane 

e. Use the detail pane 

f. All of the above. 

 

3) Which view gives me the most information about the file? 

a. Large icon view. 

b. Extra large icon view. 

c. List view 

d. Detail view. 

 

4) Which view give me a preview of a jpg file (Photos) 

a. Medium icon view. 

a. Large icon view. 

b. Extra large icon view. 

c. List view 

d. Detail view. 

e. A, B and C. 

 

5) The root folder for all of you files start with your: 

a. Document folder. 

b. Personal folder. 

c. Desktop folder. 

d. Folder called “My Documents.” 

e. Logon name. 
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6) All files you create should be stored. 

a. On your hard drive. 

b. Desktop folder. 

c. Folder called “My Documents.” 

d. Your personal folder. 

 

7) All photos should be stored in your: 

a. Document folder. 

b. Personal folder. 

c. Picture folder. 

d. Folder called “My Documents.” 

e. Logon name. 

 

8) The  system next to the folder indicate: 

a. A Parent folder. 

b. A Collapse folder. 

c. A Desktop folder. 

d. That Sub-folders exist 

 

9) The  or – symbol next to the folder means: 

a. Document folder. 

b. Expanded folders. 

c. Desktop folder. 

d. Collapse folder. 

e. Sub-folders. 

 

10) The Back button 

a. Go up a folder. 

b. Go to the sub-folder. 

c. Takes you to the previous folder. 

d. Take you to the parent folder. 

e. None of the above. 
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Intro to Windows-Part 4 

Applications 

What is a Shortcut? 

An icon is a graphically representation of object on your computer.  
These objects can represent either a programs, files or folders.  You 
can open a file or launch an application by clicking the icon. Since 
Windows is dynamic, you can create your own icons called “Shorcuts”.  
The shortcut icons have a small arrow on the bottom left corner.  
Shortcuts are particularly useful because you can put them on your 

desktop or in the Start menu without having to make a copy of the actual file itself. This 
saves space by allowing you to keep a single copy of a large program file, while placing 
one or more shortcuts to the file wherever they are convenient. 

 
 

Creating a Shortcut to a Program on the Desktop 

There are many methods to create a Shortcut to your favorite program  on the desktop: 
 

Method 1 

1. From the Start Menu, select the program by locating it from 
Pinned List or All Programs. 

2. Right click the file or folder that you want to create a shortcut 
for » select Send To » Desktop (create shortcut) 

The shortcut icon will appear on your Desktop 
 

Method 2 – Right-Click Drag  

1. From the Start Menu, select the program that you want to 
create a shortcut for. 

2. Hold down the right mouse button and drag the file or folder to 
your Desktop 

3. Release the mouse button » select Create Shortcuts Here 
The shortcut icon for the selected file or folder appears on your 
Desktop. 
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MS Paint Windows 7 
The Windows 7 version of MS Paint has gotten a major facelift since Windows XP or 
Vista.  Like Wordpad, it incorporate the new Ribbon Interface.   
 

 

The Tools  

Microsoft Paint has an assortment of painting Tools that you can use for drawing shapes 
and applying color to areas of your image in various ways. You switch between tools by 
clicking on the appropriate Icon on the Toolbar, which is located on the left side of the 
Paint window. The Toolbar looks like this:  
 

MS Paint Toolbar  ( Old MS Paint on Window 95 to Vista) 

The top row of Icons is the Selection Tools.  
The next row has the Eraser tool and the Fill tool Icons.  
The third row has the Eye Dropper tool and the Magnifying Glass tool Icons.  
The fourth row has the Pencil tool and the Paint Brush tool Icons.  
The fifth row has the Airbrush tool and the Text tool Icons.  
The sixth row has the Line tool and the Curve tool Icons.  
The seventh row has the Rectangle Drawing tool and the Polygon Drawing 
tool Icons.  
The Eighth row has the Oval Drawing Tool and the Rounded Rectangle 
Drawing Tool. Icons.  
 
The image menu had been restructured to handle image selection, 
cropping, resizing and rotation: 
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How to Make a Basic Shape 

 

 
 
The more organized Ribbon interface is a major improvement.  Not only does it look 
better, it is easier to use too.  MS Paint users who are used to the old versions will not 
have a hard time adjusting to the new Windows 7 version. 

 

 

 

 
 
 

Check Gridline and Rulers 

Rulers 

Select the basic oval 
shape. 

Start here. 
Try to drag 
diagonally to the 
opposite corner. 

http://www.online-tech-tips.com/wp-content/uploads/2009/02/clip-image0125.jpg
http://www.online-tech-tips.com/wp-content/uploads/2009/02/clip-image0088.jpg
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MS Paint Exercise – Adding fill color 

 

 
 

4. Select the oval tool.  Draw a ellipse starting from the upper left corner and drag 
to the lower right corner.  A perfect circle is created if you use a 45°.  (or hold 
down the Shift key before you drag) 

5. Select the “Outline” and "Fill" option and select a color (in the color palette). 
 

 

6. Click on one of the balloons 

7. Add a color to the other balloons 

8. We will create another file (to keep the original intact)  

9. File > Save As > type filename Balloons 1, press Save. 

10. Close the program.  You have saved another file of the balloons on the Desktop. 

   

MS Paint Exercise – More changes 

Before you make more changes, it's a good idea to save your picture as soon as you 
begin, then click the Save button on the Quick Access Toolbar every few minutes. This 
saves loss of work if the program closes unexpectedly, as in a power failure. If in the end 
you don't much want to keep the picture, you can always delete it. 

When you hit Save for the first time, you'll find yourself in a dialogue box where you're 
invited to type a name for the picture. Do so, and accept the default format, which is 
png—unless, of course, you have a particular reason for choosing some other format. 
Having typed a name, click the Save button and you'll be returned to your picture. 

After that, when you click the Save button your work won't be interrupted. 

 
 1.  Open Paint 

Edit Colors 
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 2.  Open "Balloons 1"  ( File > Open > Desktop > Balloons 1) 
 3.  Change the colors of the balloons (click on "Fill" and select another color 

and click on 
      balloons.) 
 4.  Click on the "Eraser" and erase all the strings 
 5.  Click on "Curve" and make a line from the balloon down toward the bottom 

of the page. 
 6.  Drag from middle of the straight line slightly to the left or to the right.  You 

will have a  
      curved line. 
 7.  Add curved lines to the other balloons using steps 5 and 6  
 8.  Click on the "Rounded Rectangle" and put a base below the strings 

9.  Click on "Airbrush," select the color you wish and copy the illustration on 
the next page 

  10.  Type  Balloons 3 as the filename. 
 

Free Form Selection Tool 

 
The free-form selection tool allow you to select around a 
irregular shaped object. 
 
When you wish to move anything, you must select.     This is 
a bit tricky. 

1. Click on the "Free Form Selection" from the Select 
menu. 

2. Make a circle around the object you wish to move - 
it does not have to be perfectly round.  

 
 
 
 
 
 
 
 
Use the Oval Tool to create three balloons.  Use the triangle to create the bottom of the 
balloon. 
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Fill with Color 

The Fill with color tool, or the Flood Fill tool if you like, is used to fill an area of a 
single color with a different color. Color 1 will be used if you press the left mouse button 
on the area to be filled. Color 2 will be used if you press with the right mouse button. 

Curved Line 

To create the string line. 

For a pointed curve, like this one, put your cursor somewhere 
near the finishing end of the line. With the mouse button pressed, move the cursor 
around slowly and watch the line following it. When you think the line is where you 
want it, release the mouse button. 
Now put your cursor somewhere close to the beginning of the line, press the mouse 
button and again move the cursor slowly around until you like what you see, then 
release the mouse button. 

To make a smooth curve, after you have drawn your line, put 
your cursor close to the beginning of the line. 
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Custom Colors 

 

You can use the make your own color by using the Edit Colors dialog box. 

Brushes 

Windows 7 Paint has collection new brushes – old favorites like the standard brush and 
Spray paint are still here, but they’re augmented by two calligraphy pens, oil and 
watercolor brushes, crayon, marker, and colored pencil.  Most of these are quite distinct 
and add a nice subtlety to drawings that wasn’t possible in older versions, especially the 
ones that make use of transparency. 
 

Exercise 

Play around with all of the brushes to create your own painting.  Bring it to class and 
show off your talent. 
 
To see what each brush does, just move your mouse arrow over the brush icon. 
 

 

Oil Brush 

http://www.online-tech-tips.com/wp-content/uploads/2009/02/clip-image0106.jpg
http://www.online-tech-tips.com/wp-content/uploads/2009/02/clip-image0067.jpg
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Advanced Mouse Technique 

Using the Scroll Wheel 

 
Most of the modern mouse has a scrolling wheel which allows you to scroll through a 
long document.   
 

1. Click anywhere on the page to make it the active window. 
2. Gentle roll the wheel using your index finger. 
3. Moving up will more to the top of the document, while moving down will move 

toward the bottom of the document. 
 

AutoScroll Scroll Anchor 

 
1. Click anywhere on the page to make it the active window. 
2. To use the anchor you must press the center wheel like a button instead of 

rolling it.  Try doing this on the center of the document. 
You will see an anchor icon: 

 
 

3. Slow move the mouse away from the anchor icon.  As you move it down the 
page will scroll automatically.  Notice that the further the mouse is away from 
the anchor the faster the scrolling. 

 
 

Changing the Font Size in your Browser 

 
Hold down the CTRL key when using the scroll wheel.  This is not a Windows feature, it 
only work on Internet Browser like Internet Explorer, FireFox and Chrome.   
 

1. Launch Internet Explorer. 
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2. Open your favorite web page, preferably something with text like CNN.COM. 
3. Hold down the Ctrl key while gentle moving the mouse wheel up. 

Notice that the text will appear larger. 
4. Use Ctrl + 0 to set text back to normal size. 

 
Tip:  Ctrl + and Ctrl – accomplishes the same thing. 

 
 
 

Putting it All Together (Text & Graphics) 
 

Crab Feed Flyer 
 

Text Input 
 

1. Set the Font selection the Arial and the size to 12 
2. Key in the following text 

 
 

3rd Annual 
ACC Crab Feed 
Annual Fund Raiser 
Saturday, February 26th, 2011 
6:00 – 9:00pm 
Sacramento Asian Sports Foundation 
9040 High Tech Court 
Elk Grove CA 95758  
Ticket Price: $55 per person 
Theme: Hawaiian Luau 
Casual Hawaiian Attire (Optional) 
Raffle & Entertainment 
No Host Bar 
For more information, please contact Christa Ogata at (916) 394-
6399 ext. 121 or by e-mail at chrsta@accsv.org 
7311 Greenhaven Drive Suite 187 Sacramento CA 95831 
Website: www.accsv.org 
 

3. Format as follows: 

  

mailto:chrsta@accsv.org
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3
rd

 Annual 
 

ACC Crab Feed 

 
Annual Fund Raiser 

Saturday, February 26th, 2011 
6:00 – 9:00pm 

 
Sacramento Asian Sports Foundation 

9040 High Tech Court 
Elk Grove CA 95758 

 

Ticket Price: $55 per person 
Theme: Hawaiian Luau 

 

 Casual Hawaiian Attire (Optional) 

 Raffle & Entertainment 

 No Host Bar 
 
 

For more information, please contact Christa Ogata at (916) 394-6399 ext. 121 or 
by e-mail at chrsta@accsv.org 

 
 

7311 Greenhaven Drive Suite 187 Sacramento CA 95831 
Website: www.accsv.org 

mailto:chrsta@accsv.org
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Intro to Windows-Part 5 

Maintenance & Multimedia 
 

To back up your files 

 
Open Backup and Restore by clicking the Start button Picture of the Start button, 
clicking Control Panel, clicking System and Maintenance, and then clicking Backup and 
Restore. 
 
The first time, you must create a full backup: 
 

 In the left pane, click Create new, full backup. 
 
Do one of the following: 
 

 If you've never used Windows Backup before, click Set up backup, and then 
follow the steps in the wizard. Administrator permission required If you're 
prompted for an administrator password or confirmation, type the password or 
provide confirmation. 

 

 If you've created a backup before, you can wait for your regularly scheduled 
backup to occur, or you can manually create a new backup by clicking Back up 
now. Administrator permission required If you're prompted for an administrator 
password or confirmation, type the password or provide confirmation. 

Using System Restore 

What is system restore?  Most people do not know that every time you start (boot) your 

PC, Windows automatically backup your system settings by takes a snap shot.  This snap 

shot is saved to your computer. 

 
System Restore helps you restore your computer's system files to an earlier point in 

time. It's a way to undo system changes to your computer without affecting your 

personal files, such as e‑mail, documents, or photos. 

 

Sometimes, the installation of a program or a driver can cause an unexpected change to 

your computer or cause Windows to behave unpredictably. Usually, uninstalling the 

program or driver corrects the problem. If uninstalling does not fix the problem, you can 

try restoring your computer's system to an earlier date when everything worked 

correctly. 
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Do not be confused by system restore with backup and recovery.  It does not restore 

lost files such as your photos or word document.   However system restore can be use 

the remove viruses. 

Here is the scenario: 

You are on the internet on Monday and you got a virus that prevents you from going 

to Google.  This is a common redirection virus. 

 

You can restore your system back to a previous boot time.  It’s like going back in time.  

So your computer has a problem on Monday, you can select a point in time before the 

problem, like Thursday last week. 

 

Here are the steps: 

 

1. Start Menu 

2. Open All programs. 

3. Select the Accessories folder 

4. On the sub-list select the System Tools folder. 

5. Select System Restore. 

6. Click Choose a different restore point, to see a complete list.  

7. Make sure you check “Show more restore points to see a complete list. 

8. Select the date before the day you received the vius. And click Next>.  This make 

take a few hours so be patient. 

 

To create a user account 

1. To open User Accounts, click the Start button , click Control Panel, click User 

Accounts and Family Safety, and then click User Accounts. 

2. Click Manage another account.  If you're prompted for an administrator 

password or confirmation, type the password or provide confirmation. 

3. Click Create a new account. 

4. Type the name you want to give the user account, click an account type, and then 

click Create Account. 
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AutoPlay 

When you turn AutoPlay on, you can choose what should happen when you insert 

different types of digital media into your computer. For example, you can choose which 

digital media player is used to play CDs. When AutoPlay is turned off, you are prompted 

to choose what you want to do when you insert digital media into your computer. 

1. Open AutoPlay by clicking the Start button , and then clicking Control Panel. In 

the search box, type autoplay, and then click AutoPlay. 

2. Do one of the following: 

 To turn AutoPlay on, select the Use AutoPlay for all media and 

devicescheck box. 

 To turn AutoPlay off, clear the Use AutoPlay for all media and devices 

check box. 

3. Click Save. 

Turn off AutoPlay for only one type of media 

 In the list next to each type of media that you don't want to be asked about, 

select Take no action, and then click Save. 

Note: Some devices such as digital video camera and phones may not appear in 

autoplay.  This is because these devices do not use Windows standard file system.  You 

see these devices; you must use the software or install specific drivers that come with the 

device. 

Rip music from a CD 

1. You can use Windows Media Player to copy songs from audio CDs to your 

computer. This process is called ripping. 

2. During the ripping process, the Player makes a copy of each song, stores it on 

your hard disk as a Windows Media Audio (WMA), MP3, or WAV file, and then 

adds it to your Player Library. For more information about the Player Library, 

see Getting started with WindowsMedia Player. 

 

  

http://windows.microsoft.com/en-US/windows7/Getting-started-with-Windows-Media-Player
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HOW TO BURN STUDENT CD (Vista/7) 
In Windows Vista or 7, all you need to do is the select the folder and click Burn on the 
Windows Explorer menu.  For example just select Win7 Fund Student Files which is for 
the Computer Skills 1 class.  I already have it in the Document folder on all of the top PCs. 
 

 
 
The default in Vista is “Like a USB flash drive” in Windows 7 it is “With a CD/DVD 
player”.  Regardless select the format you desire.  “With a CD/DVD player” is also 
known as Mastered or ISO 9660.  This format is the most compatible if you need to 
share it with others.  Enter any title and click Next.  
 

 
Here is where you might have a problem.  
Nothing is burned yet!  You must 
physically burn it by going into Computer 
find the DVD RW drive (ie D: on my home 

computer) , but I think it is E: 
or F:  in the lab. 
 
The icon shows a down arrow 

which means these files are ready to be 
burned.  That is because you can add 
more files.  To burn you must click Burn 
to disc. 
  

1 

2 

5 

Select File 

Burn 

4. select 
format 
title 

3. Add title 
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If you selected “Like a USB flash drive” the files are burned.  You are done.  You can add 
or delete files from the CD using “drag and drop” or “Copy and Paste” onto the CD as 
any time, just like a flash drive. 
 
If you selected “With a CD/DVD player” the files are list in the windows are only “Ready 
to be Written” as indicated by the down arrow icon.  To burn, you just click the Burn to 
disc button. 
 

 

On the next screen, uncheck “Close the wizard after the files have been burned” if you 

wish to make more than one copy.  

Otherwise the next screen will not 

appear:  

Check “Yes, burn these files to 
another disc”, if you wish to create 
more copies. 
 
Important! Wait 30 seconds after 
you insert a blank CD before you 
click on the Next button, otherwise 
Windows will not detect a blank disc 
in the drive.  You also have to enter 
the same Disc Title again. (A quirk in 
the system). 

 
Note:  To view the contents of the CD, you must press the Delete temporary files 
button. 

6 

7 
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Alternate Method 

Open the CD RW drive in Computer.  Format the CD as “With a CD/DVD player”.  Drag 
and drop files or folder into the windows.  Click Burn to disc when done. 
 
 

Burn CD/DVD Manually using Copy & Paste 
 

Burn a UDF CD using 7/Vista 

UDF 2.01 is the default format setting for 
burning CDs/DVDs on a Windows Vista system. 

1. Insert a blank CD or DVD into your 
computer's CD or DVD recorder.  If the 
AutoPlay appears, select “Burn a 
DVD/CD data disc”.  If your AutoPlay is 
disabled, then double-click on the 
CD/DVD icon in Windows Explorer. 

 
2. In the dialog box that 

appears, enter data 
disc title.   Click the 
arrow next to Show 
formatting options.  

 

Windows 7 Screen 

 

 

 

 

 

 

 

With a CD/DVD player is the same as Master or ISO 9660 

Refer to chap 6.2 Choose Between Two Formats, More Windows 7 

Why this format? 

 If you are going to give the CD to someone else that my have an Macintosh 
or older computer system. 

 Take it to the Photo Print Machine at your local drug store. 
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 Play it as a CD-R data file on your home DVD player. 

7/Vista Screen 

If you are not careful the default is the Live format instead of the Mastered like it is on 
Windows 7.   

 

 

 
3. In the Burn a Disc dialog box, type a name for this disc 

4. In Vista you can change the format.  Click Change version, and then click one 
of the following formatting options: 

 
 

5. Click OK, then click Next to prepare the disc.  This will take a few seconds. 
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6. Once the CD is formatted, you can use any Windows File Management 
technique such as cut and paste, drag and drop or send to, to copy files to 
the CD.    

 
 

Add More Data Later 

UDF or Live format means you can add more data to the CD or DVD at a later time, 
known as multi-session.  The CD or DVD media does not have to be a RW (Read/Write) 
to support multi-session. 

Erase a disc 

Only CD-RW and DVD-RW discs can be erased so you can write new data to them.  You 
can still erase files from a UDF disc, the erase space cannot be reused.  Therefore, the 
file size on a CD-R media will only grow. 

Mastered Format (ISO 9660) 

A mastered disc is only preferable if you want to use the disc in CD or DVD players or in 
computers which do not have Windows XP or Windows 7/Vista installed. 
Choose the Mastered format when you need a highly compatible disc that will play in 
computers with an older version of Windows or in media devices such as CD and DVD 
players that can read digital music and video files. For more information about choosing 
a disc format, see Which CD or DVD format should I use? 
 The selected files are copied to the disc. When the disc burning is complete, the disc 
burner tray will open and you can remove the disc. You can now use the disc in another 
computer or media device. This type of disc does not need to be closed. 
 
Insert a writeable CD or DVD into your computer's CD or DVD recorder. 

1.  In the dialog box that appears, click Burn files to data disc. 

2. In the Burn a Disc dialog box, type a name for this disc, and then click Show 
formatting options. 

Drag or use 
copy/paste to stage 
files to be burned. 
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3. Click Mastered, and then click Next. An empty Windows Explorer appears. 

4. Open the folder that contains the files you want to burn, and then drag the 
files into the empty disc folder. 

 
Files ready to burn. 

5. After you have dragged all file to this 
windows, they are just ready to be burned.   
To initiate the burn process, click Burn to 
disc on the Windows Explorer tool bar. 

6. To review the content of the CD you must 
click on Delete Temporary Files. 

The selected files are copied to the disc. When 
the disc burning is complete, the disc burner 
tray will open and you can remove the disc. 
You can now use the disc in another computer 
or media device. This type of disc does not need to be closed. 

Files are not burned 
until you click on Burn 
to disc button. 
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Multi-Session 

The number of sessions a compact disk has refers to the number of 
different continuously-written chunks of data that are placed on the disk. 
Traditional CD formats such as standard CD audio and CD data, are said to 
be single session; everything that is ever going to be on the disk is placed 
there at once when the disk is manufactured. Some newer CD formats 
however use more than one session, and are called multi-session drives. 
Using multiple sessions means that information can be written to the first 
part of the disk, and then later more information can be appended to it in 
the unused space left after the first session. 
 

Make a Photo CD 

Chap 6, p198, more Windows 7 
 

 
 

1. Select the photo you want to burn. 
Shift Key – Contiguous selection.   
Ctrl Key – Non-contiguous selection. 
 

2. Press the Burn button. 
3. Select the correct format, either Live for Mastered.  Use the same process 

explained in the previous exercise. 

Review of Contiguous Selection Process (p. 198) 

1. Select the first picture.  Contiguous photos in the icon view are top to bottom, 
left to right. 

2. Hold down the Shift key, then select the last photos. 
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Import Photos from Your Digital Camera 
Refer to 7.5 Typing an Address, Windows 7 for Seniors, 5.12 – More Windows 7 
2 method for connecting your camera to the PC. 
 
Method 1: USB Cable that came with your camera. 

 
 
Method 2: Memory Card (xD, SD, CF, Memory Stick) 

 
Remove the memory card from your digital camera.  
If you do not have the proper slot on your PC or 
Laptop, you can purchase a Universal Card Reader 
(shown right).  Most Laptop today include an SD reader which is the most popular 
memory on digital camera. 
 

After the drivers installation is finished, the AutoPlay menu will pop-up. 

Autoplay 
If you AutoPlay dialog does not appear, 
go to Computer and right-click on the 
Camera’s Memory Card icon. 
To change Autoplay default go to Start 
menu>Default Programs. 
 
Select the option Import pictures using 
Windows. 
In the bottom right corner of the 
screen, a small window asking if you 
want to tag the pictures will appear. 
You can type a general tag for the 

http://en.wikipedia.org/wiki/Tag_%28metadata%29
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pictures that you are about to import. Tags can be very useful for organizing and finding 
your pictures. 

 

If you don't want to insert a tag just leave that space blank and click on Import. 
If you want to customize the import settings, click the Options button. Now you can 
change the following settings: where to import the pictures (the default folder is 
Pictures - if you want another folder click on Browse and select or create that folder), 
the name of the folder (by default the name of the folder will be the date when the 
pictures are imported plus the tag you typed) and the file naming convention. 
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When you have finished, click the OK button. These settings will apply to all the pictures 
you will import from now on. 
After you click on Import, Windows Vista starts moving all your pictures. If you want the 
pictures to be deleted from your camera after the import process is finished, click the 
Erase after importing checkbox. 

 

After the process is finished, Windows Photo Gallery will start and you will be able to 
see all the pictures that were imported. 

 

Where are my pictures? 
In the Picture folder, the sub-folder created is based on date + tag name.  In this 
example the folder is “2010-07-09 Computer Class”. 
 
XP user: My Document\My Picture\2010-7-9 Computer Class. 
 
Vista/7 users: personal folder>Pictures>2010-7-9 Computer Class. 
 
Both Vista and 7 save the photos to the same virtual folder, with the except that they 
called it “My Picture” instead of “Pictures”. 
 

  



51 

 

Exercise – Guess the URL (Address)  
The Uniform Resource Locator is the address to a particular web page.  Every web page 
has a unique URL assign to it. 
 

Info: The Uniform Resource Locator was created in 1994by Tim Berners-Lee, the 
inventor of the WWW. 

 

Find these web sites without using Google or any other search engine?   
Write the web site address or URL,  Note: URL are all lowercase with no spaces.  End 
the URL with the proper extension (.com, .gov, .edu, .mil, .net, .ca). 
 
What is my IP Address: _____________________ 

The White House: _______________________________ 

City of Sacramento (Government):___________________________ 

IRS: _____________________________ 

US Army: ___________________________ 

Navy: _________________________ 

Starbucks Coffee: ______________________________ 

CSUS (California State University of Sacramento): ____________________ 

Sacramento City College: ______________________ 

KCRA: _________________________ 

Dell Support: _________________________ 

Microsoft Support: ___________________________ 

ABC TV Network: _____________________ 

Hobby Lobby (RC Models): _______________________ 

United Airline: _____________________ 

Southwest Airline: __________________ 

AT&T Portal: _____________________ 

Google: ___________________________ 

Google in Japan:________________________ 

 

Wrong Address 
Refer to 7.6, Window 7 for Seniors. 
If you type the wrong address, you will not always get a blank page.   That depend on 
how your Web Browser default is set.  It my automatically go into Google is your default 
search is set to Google.   
 
The second reason is that someone has purchase that Domain name, but has not 
created a web site or speculator have purchased the domain to resale or the sole 
purpose of profit. 
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Saving a Web Address 
7.12 

1. Click Favorite. 
2. Click Add to Favorite. 

Create favorite bar or shortcut on desktop. 

 
Drag favorite icon to the desktop to create shortcut or favorite bar. 
 

 
 

Changing my Home Page 
7.13 
The Home button reset you web page to the default home page or the page you see 
when you first load Internet Explorer. 
 
Homework 
 
Study the Internet Glossary on p254-255. 
Hypertext  

Text on an HTML document which has been organized to provide links between other 
elements of the same document or other documents on the World Wide Web. Selecting a 
hypertext link (usually by clicking the mouse pointer on the text itself) will summon up 
additional information.  

Internet  
The series of interconnected networks that includes local area, regional, and national 
backbone networks. Networks in the Internet use the same telecommunications protocol 
(TCP/IP) and provide electronic mail, remote login, and file transfer services.  

 
Search Engine  

This term refers to a program that helps users find information in text-oriented databases. 

 
Web Browser  

A program which uses a graphical approach to finding and displaying the information on 
the Internet.  

World Wide Web (WWW)  
A hypertext-based, distributed information system in which users may create, edit, and 
browse hypertext documents. Also called W3 or simply "the Web."  
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Changing your Home Page 
The term home page can have several meaning, but in terms of you browser; the home 
page is the first page you see when you first launch Internet Explorer or an Web 
Browser. 
 

 
1. Go to the website you 

want to be your home page. 

2. Make it you home page 

either by finding the link on the 

page or going to Tools>Option or 

the Gear button in IE9. 

3. Click Use current.  What 

this does it the save you your 

currently have opened as your 

home page. 

 

Tip 
If you are with AT&T and your 
default email is AT&T Yahoo, 
then you should set your home 
page to: ATT.NET 
 
Portal 
This is sometime known as your 
Web Portal page where you can 

easily access current news, weather, stocks report. shopping and e-mail.  Many Portal 
Pages  include the same Google Search Engine and they can be personalized to your 
own taste. 
 

Other popular web portal pages. 

 
msn.com 
yahoo.com 
igoogle.com 
aol.com 
excite.com 
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How to Use Tabbed Browsing 
P267 Tips 
Launch Internet Explorer 7 or 8 and your home page opens in the first tab. To view other 
sites at the same time, just click the new tab button in the toolbar and then type the 
address of the site you want to visit in the address bar.  Your home page stays open in 
the first tab. Closing tabs is as easy as opening them. Just click the close button that 
appears on the right side of the selected tab.  
 

Tab Exercise: 
1. Select the 2nd tab and go to this web site: igoogle.com 

2. Make it you home page either by finding the link on the page or going to 

Tools>Option. 

3. Do the same for the 3rd, 4th and 5th tab: 

Tab 3: msn.com 

Tab 4 sacbee.com 

Tab 5: hartcomputerclass.org 

 

 

How to set Multiply Home Pages & Use Tabbed Browsing 
The home page is the first page you see when you open your Browser.  In IE7,8 and 9 
you can save multiply page using the Tab.  The tab look like the tab in a typical file folder.   
We will show how you can save 5 different home page.  
 

Tab Exercise: 
 

1. Go to the website you want for your home page:  ATT.NET if you are with AT&T. 

2. Select the 2nd tab and go to this web site: google.com 

 

 

 

 

3. Do the same for the 3rd, 4th and 5th tab: 

Tab 3: bing.com 

Tab 4: cnn.com 

2nd Tab 
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Tab 5: kcra.com 

* You can use your own favorite website instead of the one shown above. 

4. Make it you home page either by finding the link on the page or going to 

Tools>Option or the Gear button in IE9. 

 
 

5. Click Use Current button. 

6. Click OK. 

 

Tips for Windows 7 users 
Here you see a number of tips for Windows Vista users 
covering a range of different topics. 
 
How can I view the computer tips? 

The computer tips on this website are published in the PDF 
format. You can open, view, print or download these files with 
the program called Adobe Reader. PDF (Portable Document 
Format) is a universal file format that preserves the fonts, 
images, graphics, and layout of any source document, 
regardless of the application and platform used to create it. 
 
Help nothing happens when I click? 
Most computers already have this software installed, but if yours does not, you can 
download Adobe Reader for free from the Adobe website. 

Download 
 
http://www.visualsteps.com/morewin7/tips.php 
 

Get you Certification 
You can get a certificate from Visual Steps subject by completing and passing the 
multiply choice tests on this website: 
 
http://www.computercertificateforseniors.com/ 

How to Google 
 

http://www.adobe.com/
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1. In the Address bar type: google.com if it is not your default home page. 
2. Enter the keywords in the Google search box 

 

Kona coffee 

 
3. Press enter or click on the Google Search button. 

Auto-complete and Instant Search 

Auto-complete will show suggested text as you start typing saving you time.  
Instant will start to show you result as you type.  If you have a slow internet 
connection, it may be better to turn this feature off. 
 

http://www.google.com/webhp?complete=0 

To change your search preferences, you must go here: 

http://www.google.com/preferences 

I’m Feeling Lucky 

This will take you to the first web page of the Google search result.  For this to work you 
must turn off the Instant feature by using the URL above. 
 
 
  

Address 
Bar 

Google Search 
Box 



57 

 

 

Google Search Result 
That is how Google make money!  When you type a keyword “Kona Coffee”, company 
pay Google to show their ads you the search result.  The untainted result is the 4th listing. 
 

 
As you can see the first untainted result from the Google Search Engine is 
www.konacoffee.com.  The Shopping result is another Google service in addition to 
AdWords.   This is a very controversial area of contention among retailer on how to get 
their ads in this area.  

o More Results: When there are more than two results from the same site, access the 

remaining results from the “More results from…” link. 

Ads Ads 

1st 

2st 

Ads 

Statistics 

http://www.konacoffee.com/
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When Google returns more than one page of results, you can view subsequent pages by 

clicking either a page number or one of the “o”s in the whimsical “Gooooogle” that 

appears below the last search result on the page. 

 

If you find yourself scrolling through pages of results, consider increasing the 

number of results Google displays on each results page by changing 

your global preferences. 

In practice, however, if pages of interest to you aren’t within the first 10 results, 

consider refining your query instead of sifting through pages of irrelevant results. 

Sponsored Links: Your results may include some clearly identified sponsored links 

(advertisements) relevant to your search. If any of your search terms appear in the ads, 

Google displays them in boldface type. 

Plan a Trip with Google Map 
 

1. Click Map on the Google 
home page.  Or type: 
map.google.com 

2. Click on Get direction 
button. 

 

3. Enter your starting 
address in box A. 

4. Enter the destination 
address in box B. 

5. Click on the GET 
DIRECTIONS button. 

Email Attachment 
8.7, Including an Attachment Windows 7 for Seniors. 

1. Compose a new e-mail. 
2. Subject: Photo attachment. 
3. Attach a Picture from the Sample Picture folder and send it to a fellow classmate. 

 

Saving an Email Attachment 
Tip p303, Windows 7 for Seniors. 

4. Open wwwhttp://www.visualsteps.com/info_downloads.php 
5. Fill out the form to receive free PDF attachment. 

http://www.googleguide.com/preferences.html#number_of_results
http://www.googleguide.com/preferences.html#number_of_results
http://www.googleguide.com/ads.html
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More Windows 7 – Intermediate 
1) Adapting Your Work Environment 

a) Arranging Icons  Desktop 
b) Creating Shortcut 
c) Delete Icons 
d) Pinned Programs 
e) Quick Launch 
f) Modify Start Menu 
g) Gadgets 

 
2) Setting Up Windows 

a) The Control Panel 
b) Setting the Date and Time 
c) The Ease of Access Center 
d) Setting Default Programs 
e) Associating a File Type with a Program  
 

3) User Account 
 

4) My Computer no Your Computer 
a) Hard Disk Properties 
b) Gigabyte, Megabyte, Kilobyte 
c) DVD drive 
d) Removable Media 

 
5) Photos, Music and Videos 
 
6) Burning File to a CD, DVD or Blu-ray Disc 
 
7) Interesting Programs 

a) Sticky Notes 
b) Snipping Tool 
c) Jump List 
d) Aero Peek 
e) Aero Shake 
f) Aero Snap 
 

8) Windows Explorer Libraries 
 

9) System Management and Maintenance 
a) Installing an application 
b) Installing Adobe Reader 
c) Open a PDF 
d) Cleaning up your hard drive 
e) Defragmenting your hard drive 
f) Ctrl+alt+del and Task Manager p. 322 
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g) System restore 
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Default Program and File Type 
p62, ch 2.5, more Windows 7 
 
When you double-click a file to open it instead of by using the File menu in a program, 
Windows examines the file name extension. If Windows recognizes the file name 
extension, Windows opens the file in the program that is associated with that file name 
extension.  

View your File Type 

How to display all file name extensions for installed programs 
Depending on your settings in Folder Options, you may be unable to see the file name 
extensions of your files. To display the file name extensions of your files if they are not 
displayed, follow these steps:  
 

1. Open  any Windows Explorer Window (Document) 
2. On the Organize menu , click Folder and Search Options. 
3. Click the View tab. 
4. Click to clear the Hide extensions for known file type check box. 

 
But what if you want to change the program that opens when you double-click a file 
that has a certain file name extension? For example, a text file that has a .txt file name 
extension typically opens in Notepad. What if you want to open the file in Microsoft 
Word instead? How would you do that?  

Override the Default File Association 

1. Right-click on a file for which you want to change the program that opens that 
file type, and then use either of the following methods to change which program 
starts:   

 
2. Click Open With to choose the program that you want.  
3. Point to Open With, and then click Choose Program to choose the program that 

you want. 
4. Notice that the Open With dialog box appears. Use one of the following methods 

to select the program that you want to use to open this kind of file:  
5. In the Programs list, click the program that you want.  
6. Click Browse, locate and then click the program that you want to use, and then 

click OK. 
7. Click to select the Always use the selected program to open this kind of file check 

box if it is not already selected. 
8. Click OK. 

 
From now on, Windows will open all files that have this file name extension in the 
associated program. To change this, you would have to follow these steps again and 
associate a different program with this file name extension. 
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Common File Extensions 
P120, ch 4.9, Various File Types, more Windows 7 
 
Windows uses the file extension to determine the file type which is how it determine 
the default program.   The file extension also informs Window which icon to display to 
represent the default program. 
  

TXT – Text File created by Notepad 
RTF – Rich Txt Format created by Wordpad 
DOC – Microsoft Word Document 
BMP – Bitmap created by MS Paint 
JPG - Jpeg image file (Digital Camera) 
GIF – Gif image file 
WMA- Windows Media Audio 
WMV- Windows Media Video 
MP3 – Compressed audio file 
EXE- Executable program file 
XLS – Microsoft Excel Spreadsheet 
PPT – Powerpoint presentation 
TTF – True Type Font 
PDF – Adobe portable document format 

 

Change File Association 
The software that is assigned to do 
some action with or to a file is said to 

be associated. More than one 
program may be associated with a 
given extension, each carrying out a 
different (or at least differently 

named) action. For example, .html 
or .htm files can have Internet 

Explorer associated to open (i.e., 
display) the file and Notepad or 

FrontPage associated to edit the 

file.Look at the list of file types and 
their associations for your 
computer. 
 

1. In Control Panel, click Programs and click Default Programs>Associate a file 
type or protocol with a program . 
Tip: or select Default program in the Start menu. 

2. The following dialog box window (see Figure 4.2) will appear: 
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Change Program Association with Open With 
Many of you have had the experience of installing some new software only to find that, 
without asking, the installation has changed your file associations so that some of your 
favorite programs no longer work. Knowing how to manage file associations will allow 
you regain control of your computer. One way to manage file associations is with the 

File Types list .  
 
You can edit the actions for a file type. 

 
If you are only interested in an occasional use of a program to open a file or want 
a quick way to change the default action, there is a simple procedure. 
 

1. In Window Explorer, select (highlight) the file to be changed then right click the 
file icon. 

2. Right-click on the file and select to Open With and then select and click Choose 
Default Program. 
 

 
 
If the list does not contain the desired program there is a Browse button which will 
allow you to look for the appropriate executable from all the files on the computer.  
There is a box to check if you “Always use the selected program to open this kind of file”.  
Checking this box will change the default file association. 
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AutoPlay 
P 65, ch 2.6, more Windows 7 
Windows Vista makes it easy to adjust what happens when you want to transfer media 
file to your computer or just play or view them, be it Music, Pictures, Video or DVD’s. 
The secret is in the AutoPlay settings. Lets take a look at how to adjust them.  
 
To access the Autoplay dialog: 
 
Control Panel (Category View)>Autoplay 
Or 
Control Panel>Hardware and Sound>Play CDs or other media automatically 
 

 
 

The default is the use AutoPlay for all media and devices, indicated by the check box in 
the upper left corner of the dialog box. 
 
That is why the AutoPlay screen appears when you insert a CD or flash drive. 
 

Disable AutoPlay 

Just set all media to Take 
no action. 
 
Click Revert to default if 
you think you messed up. 
Ch 2.9 Tip, more Windows 7 


